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Introduction

The possibilities for designing and producing print products are 
many and varied. Whether typography, image editing, graphic ele-
ments, page layout, bleed, colour management or PDF export - the 
Adobe CC programs offer a wide range of functions with countless 
menus and therefore a lot to consider when creating print data.  
 
For this reason, we have listed the most important basics on the 
following pages to help you create perfect print data.
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Further information on this topic can be found at:

www.eci.org (ICC profiles and colour management)
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PDF

Print PDF

 > Please save your print file as PDF.

 > Create the PDF as PDF/X-4 (preferably without RGB or 
Lab), i.e. with the following setting: Standard: PDF/X-4,   
Bleed: 3 mm, Color Conversion: Convert to Destination (Pre-
serve Numbers), Destination Profile (e.g. ISO Coated v2).

 > Use our recommended colour presets and PDF export presets 
(from page 3).

 > RGB data and spot colours contained in the PDF will automati-
cally be converted to CMYK according to your order.

300 ppi

Image resolution

 > Photos, images, graphics and greyscale: 300 - 400 ppi.

 > Line images (e.g. drawings or rasterised texts with a small font 
size): 800 - 1,200 ppi.

 > Posters/plots: 150 - 300 ppi.

 > Lower image resolutions may result in blurring or pixelation. 
Higher resolutions usually lead to an imperceptible improve-
ment in the printed image and increase the storage space.

800 ppi 400 ppi 300 ppi 250 ppi

200 ppi 100 ppi150 ppi 72 ppi

Colour/halftone images:

Line images:

1.200 ppiVectors 800 ppi 300 ppi

Document colours

 > Send your data in CMYK and include the destination colour 
profile.

 > For monochrome prints, ensure that your data only contains 
one colour channel.

 > Do not create black text as a mixed colour in 4C. 

 > Avoid using the colour ‘registration marks’.

 > Use the following colour values for deep black areas:                        
C 50, M 20, Y 20, K 100.

 > Configure grey images or areas as greyscale.

 > Only use the spot colours that you have ordered in your do-
cument. Provide the colours with a correct and unique name 
(e.g. PANTONE 179 C). This also applies to finishing and tool 
colours, such as UV or relief varnishes, embossing, die-cutting, 
perforations, etc..

 > Create the finishing or tool colour as a separate spot colour 
in the document. Make sure to send us the following PDF do-
cuments:

> 1x data file for print production

> 1x the finishing or tool colour only

>  1x both combined (whereby the finishing or tool colour must 
be set to overprint)

>  The trim box (final size after trimming) and the position of 
individual elements must be identical in all PDF documents.

> The PDF must contain vector data (no pixel images).

>  The tool colour (e.g. cutting die) must be created as a conti-
nuous path.

>  The PDF document must not contain any elements covered 
up with white elements.

PRINT DATA CHECKLIST
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TT
Fonts

 > Embed fonts in the PDF document to prevent problems with 
the spacing and typeface.

 > When sending open data, the fonts must be provided or con-
verted into outlines/curves.

Heenemann Heenem
Heenemann Heenem
Heenemann Heenem
Heenemann Heenem
Heenemann Heenem
Heenemann Heenem
Heenemann Heenem

Trimming and bleed 

 > Set a bleed of 3 mm to avoid white slivers around the edges, 
that can occur during production due to cutting discrepancies.

 > Please note that all graphic elements or background images 
that are to extend to the edge must be integrated into the 
bleed area. All other elements should be placed at least 4 mm 
from the edge of the final page size.

Line thickness

 > Make lines with at least 0.25 pt to prevent thinner lines from 
breaking away.

 > Lines that are still too thin in the PDF will be automatically 
corrected. The line width in fonts will not be adjusted. 

1
2

3
4

Page sequence

 > For multi-page products, please send consecutive single pages 
and no spreads (this also applies to saddle stitched covers). 
For folded flyers, please arrange the pages according to the 
data sheet.

 > Make sure all superfluous pages have been deleted.

Brochure covers

 > Covers for perfect binding and thread sewing require a spine. 
The spine thickness varies depending on the page count and 
grammage of the paper. You can find the spine thickness in 
the web shop or you can contact us if you have any questions. 
We will be happy to provide you with information about your 
product.

 > The PDF must be supplied as a spread sheet including spine 
width.

 > In order for the book block to adhere firmly to the cover, the 
spine on the inside cover spread must be surrounded by 3 mm  
white to the right and left of the design.

Example:

Cover
Page  2

Cover
Page 3

Sp
in

e

3 mm 
white

3 mm 
white

 

 > Attention image crossovers! Please note that graphic ele-
ments are lost in the transition between cover and content 
page due to the gluing. If you have image crossovers or  
text in this area, these must be moved out of the binding area  
by 5 mm.

Example:

Cover
Page 2

Content
Page 1

5 mm 5 mm

PRINT DATA CHECKLIST
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Installing the profiles

You can download the ECI ICC profiles at www.eci.org. The ‘ECI_Off-
set_2009’ package contains all the necessary colour profiles. To be 
able to select the ICC profiles (e.g. ISOcoated_v2_eci.icc) in the Ado-
be Creative Cloud, they must be stored in the following directories:

Mac Library > ColorSync > Profiles

Win Programs > Shared files > Adobe > Color > Profiles 

 (or click right mouse button > install)

Configuring colour settings in Photoshop

Go to ‘Colour Settings’ in Adobe Photoshop and make the settings 
as shown above. Then click on ‘Save’ and select a file name (e.g. 
HE_sRGB_ISOcoatedv2). You can then load your colour settings in 
all Adobe programs or synchronise them via Adobe Bridge. To do 
this, select your setting in the Bridge under ‘Edit’ > Colour Settings 
and click on ‘Apply’.

Explanation of the settings

The setting (1) serves as an example for offset printing on coated 
paper. The ‘Working Spaces’ area (2) determines which profiles you 
work with by default. The profiles mainly come into play when you 
open image data in which no profiles are included. The settings the-
refore influence how your image data is displayed on the monitor 
and how it is converted. The ‘Color Management Policies’ (3) ensure 
that images that are already provided with a profile (e.g. by a digi-
tal camera) are not converted to the working colour space without 
being asked. The rendering priority is defined in the ‘Conversion 
Options’ (4).

Applying the profiles

For digital printing or an order in the web shop, use the ICC profile 
‘ISO Coated v2 (ECI)’ as standard. This applies to all papers. In offset 
printing, the colour profile depends on the substrate and the prin-
ting screen. For coated paper, we recommend the ‘ISO Coated v2 
(ECI)’ profile (AM screen) or ‘PSO Coated NPscreen ISO12647 (ECI)’ 
for FM screens. For uncoated paper, use the profile ‘PSO Uncoated 
ISO12647 (ECI)’ (AM screen) or ‘PSO Uncoated NPscreen ISO12647 
(ECI)’ for FM screens. You can assign the required working colour 
space in Adobe InDesign as follows: Menu > Edit > Assign Profile...

Adobe InDesign: Attention! When loading the setting, the ‘Color 
Management Policies’ change to ‘CMYK: Preserve Numbers (Ignore 
Linked Profiles)’ (5). This is intentional and should avoid an unwan-
ted CMYK to CMYK conversion!

1

2

3

4

ADOBE COLOUR SETTINGS
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PDF export from Adobe InDesign

With InDesign you can export a PDF file directly and securely. Please 
use a PDF/X-4 without RGB or Lab to save your data. Proceed as 
described below:

1. Go to ‘Export’ via the ‘File’ menu. 

2. Select a file name and ‘Adobe PDF (print)’ as the file type. Then 
click on ‘Save’.

3. Select the Adobe PDF standard ‘PDF/X-4:2008’ in the PDF ex-
port dialogue.

4. Go to the ‘Marks and Bleeds’ area and tick the ‘Crop Marks’ 
box. Also set the offset and bleed to 3 mm. If you have defined 
the bleed area in your document, you can alternatively use the 
‘Use Document Bleed Settings’ function (1).

5. Go to the ‘Output’ area and set the colour conversion there to 
‘Convert to Destination (Preserve Numbers)’ (2). Also include 
the ‘Document CMYK’ as the destination profile. For digital 
printing, use ‘ISO Coated v2 (ECI)’. This applies to all papers. In 
offset printing, the colour profile depends on the substrate and 
the print screen (see page 3).

6. You can then save the settings and export the document.

PDF check in Adobe Reader and Acrobat Pro

Finally, you should check whether your PDF file has been prepared 
correctly. If you only have Adobe Reader available, the check is limi-
ted to the following points. Additional checking options in Acrobat 
Pro can be found on page 6.

1. Check whether all superfluous pages have been deleted.

2. Go to ‘Properties’ via the ‘File’ menu and check whether all 
fonts are correctly embedded in the PDF. In the ‘Fonts’ section, 
‘Embedded’ or ‘Embedded Subset’ must appear after each font 
(3).

3. In the ‘Description’ section, you will find the ‘Page Size’ of your 
file. If bleed and crop marks are present, the document should 
be larger than the final page size.

4. Check the image resolution by enlarging (zooming) the docu-
ment view to at least 200 %. With an image resolution of at 
least 300 ppi, no pixels should be visible. If pixels are still visi-
ble, the image resolution is probably too low.

1

2

3

CREATE AND CHECK PDF
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Output preview in Acrobat Pro

With the Acrobat Pro output preview, you can check the separations 
(colour separations) of your PDF file for correctness and simulate 
overprinting. To do this, proceed as described below:

1. Under ‘Tools’, select ‘Print Production’ and open the ‘Output 
Preview’ (1).

2. Check that only the required colours are present and that over-
printing elements are displayed correctly. If you find unwanted 
colours or overprint settings, correct the original file and ex-
port a new PDF file.

Preflight in Acrobat Pro

In addition to the output preview, Acrobat Pro also has a preflight 
function that checks your PDF file for printability and corrects it if 
necessary. The preflight report provides you with detailed informa-
tion about problems in your PDF. Proceed as described below:

1. Under ‘Tools’, select ‘Print Production’ and open ‘Preflight’.

2. In the ‘Prepress’ area, use the ‘Sheetfed offset (CMYK)’ profile 
of the ‘GWG’ (Ghent PDF Workgroup) (2).

3. Click on ‘Analyze’ to start the process.

4. Examine the ‘Results’ (3). Serious errors are marked with a red 
cross, warnings with a yellow caution sign. If you find errors, 
correct the original file and export a new PDF file. We do not 
recommend automatic correction by the preflight profile.

Attention! Not every error reported by the programme cau-
ses an actual problem. If you are unsure, order a data check or 
contact us if you have questions.

1

Tip:

For better control, you can set the ‘Preview for Overprin-
ting’ in the ‘Preferences’ under ‘Page Display’ to ‘Always’. 
This means that overprinting elements are always di-
splayed correctly in Acrobat!

2

3

ADOBE ACROBAT PRO
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  DIN-A Series

A0 841 x 1,189 mm

A1 594 x 841 mm

A2 420 x 594 mm

A3 297 x 420 mm

A4 210 x 297 mm

A5 148 x 210 mm

A6 105 x 148 mm

A7 74 x 105 mm

A8 52 x 74 mm

A9 37 x 52 mm

A10 26 x 37 mm

  DIN-B Series

B0 1,000 x 1,414 mm

B1 707 x 1,000 mm

B2 500 x 707 mm

B3 353 x 500 mm

B4 250 x 353 mm

B5 176 x 250 mm

B6 125 x 176 mm

B7 88 x 125 mm

B8 62 x 88 mm

B9 44 x 62 mm

B10 31 x 44 mm

DIN-C Series

C0 917 x 1,297 mm

C1 648 x 917 mm

C2 458 x 648 mm

C3 324 x 458 mm

C4 229 x 324 mm

C5 162 x 229 mm

C6 114 x 162 mm

C7 81 x 114 mm

C8 57 x 81 mm

C9 40 x 57 mm

C10 28 x 40 mm

FoRMAtE UND FoRMELN

A0

A1

A2
A3

A4
A5
etc.

DIN standards

The German Institute for Standardisation has been defining various standards and units of measurement since 1922. The standardised 
formats are recognised throughout Germany. There are also country-specific standards that apply, for example, to Europe (EN), the USA 
(ANSI) and Japan (JIS) or worldwide (ISO). 
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  DIN-A Series

A0 841 x 1,189 mm

A1 594 x 841 mm

A2 420 x 594 mm

A3 297 x 420 mm

A4 210 x 297 mm

A5 148 x 210 mm

A6 105 x 148 mm

A7 74 x 105 mm

A8 52 x 74 mm

A9 37 x 52 mm
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B0 1,000 x 1,414 mm

B1 707 x 1,000 mm
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FoRMAtE UND FoRMELN
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etc.

DIN-A series

The DIN-A series is the most common. It is used for various printed 
products and refers to formats such as brochures, postcards, letter-
heads and flyers. The standard was developed by Walter Porstmann. 
Starting from an area of one square metre (A0), rectangles are for-
med whose ratio of the short side to the long side remains the same 
when cut in half. The number indicates how often the original A0 
format must be cut or folded in order to obtain the specified size.

DIN-B series

The DIN-B series is based on the B0 format with a size of 1,000 mm 
x 1,414 mm. DIN B is exactly 1,414 times the size of DIN A.

DIN-C series

The DIN-C series starts at DIN C0 with 917 x 1,297 mm. DIN C lies 
exactly between the two sizes DIN A and DIN B and describes the 
size of different envelopes for sending printed products from the 
DIN A series.

Table overview

Tip:

You are not bound to the DIN standards for print produc-
tion. Use custom sizes in the web shop or contact us for 
a personalised offer. We will be happy to recommend a 
suitable format for you.

DIN ISO STANDARDS
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Contact

Buch- und Offsetdruckerei
H. Heenemann GmbH & Co. KG

Bessemerstraße 83–91
12103 Berlin

Phone: (030) 7 53 03 – 0
Fax: (030) 7 53 03 – 131

info@heenemann-druck.de
www.heenemann-druck.de

Questions about web shop products:

Phone: (030) 7 53 03 – 167
shop@heenemann-druck.de

Requests for quotation:

anfrage@heenemann-druck.de

Print data preparation:

Phone: (030) 7 53 03 – 220
druckvorstufe@heenemann-druck.de

Visit us at our printing centre at Bessemerstrasse 83-91. We look forward to seeing you!

How to find us

Thanks to its central location in Berlin-Schöneberg, our print shop is 
easy to reach from anywhere. Free car parking is available on the com-
pany premises. The nearest bus stop (Bessemerstraße) as well as U-
Bahn and S-Bahn stations (U Kaiserin-Augusta-Straße, S Priesterweg) 
are only a few minutes away.

P

AlboinplatzAlboinplatz

EythstraßeEythstraße

D
om

na
ue

r S
tr

.
D

om
na

ue
r S

tr
.

Ro
th

ar
iw

eg
Ro

th
ar

iw
eg

A
lb

oi
ns

tr
aß

e
A

lb
oi

ns
tr

aß
e

AlboinstraßeAlboinstraße

Be
ss

em
er

st
r.

Be
ss

em
er

st
r.

Bessemerstr.Bessemerstr.

In den AlboingärtenIn den Alboingärten

BosestraßeBosestraße

Suttn
erst

raße

Suttn
erst

raße

Kaiserin-Augusta-Straße U6

PriesterwegS

Südkreuz

S

Bessemerstr.Bessemerstr.

BUS
106

INFORMATION


